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The Basics
Establishing a Home Directory / Opening Final Cut Pro / Setting your System Settings, aka Pretty
Much the Most Important Thing to Remember / Familiarizing Yourself with the Final Cut
Pro Workspace

(Please see the Glossary for underlined terms.)

Establishing a Home Directory

Before you begin any work in Final Cut Pro, you should set up a Home Directory. This is

the folder where you will save your Final Cut Pro project, all the files you use in your
project, and anything you Export. You will also set your System Settings to link to your
Home Directory.

First create a folder on your external hardrive called “Final Cut_Pro.” When you set your
System Settings (details to follow) you will direct Final Cut Pro to this folder. Also notice
that there is a separate folder for “iTunes Music” and “Still images.” These are just a few
examples of folders you can create to better organize the files you Import into your project.
See page 12 for details about importing media.
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Opening Final Cut Pro

Now you are ready to open Final Cut Pro and get started. If you want to import footage,
you will want your camera or a miniDV deck connected to the computer. If these are not
connected with a firewire properly, you will see this message:



External A/V g

Unable to locate the following external devices:

Apple FireWire NTSC (720 x 480)

Your system configuration may have changed, or your deck /camera
may be disconnected or turned off.

Please check your connections and click "Check Again”, or click
“Continue” to set external device selection to None.

[~) Do not warn again

(" Continue ) ( CheckAgain )

Connect your camera or miniDV deck properly. (Camera: in VCR or playback mode,
connected to the computer with a 4-pin to 6-pin firewire. MiniDV deck: on and connected
to the computer with a 4-pin to 6-pin firewire). Select “Check Again”and you’ll be good to

go.

On the other hand, if you do not need to import footage and you just want edit your
y p g youj ¥
project, select “Continue.”

Setting your System Settings, aka Pretty Much the Most Important Thing to Remember

Before you get started or proceed with editing, you must do one more thing. In addition
to saving your project and all the files associated with it to a Home Directory, you also need
to set your System Settings so that Final Cut Pro knows exactly where to store automated
file information. After reading this, you may think it is a bit tedious or unnecessary, but we
assure you that it is absolutely essential that you follow these guidelines in order to avoid
major problems with your video project.

Immediately after opening Final Cut Pro, select “Final Cut Pro” in your toolbar. Then
choose “System Settings.” A window will pop up. All you need to worry about is the far left
tab called “Scratch Disks.” You need to set all four of the available options to the same
folder. “Video Capture,” “Audio Capture,” “Video Render,” and “Audio Render” all link
from the first line. Then individually set your “Waveform Cache,” “Thumbnail Cache,” and
“Autosave Vault.”




System Settings

Scratch Disks | Search Folders |, Memory & Cache \ Playback Control |, External Editors |, Effect Handling \,
Video Audio Video Audio
Capture Capture Render Render

4 vl 4 4 ( Set... ) 53.3 GBon lacie 120gb#9:FinalCutPro:Videol O
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Seves <None Set>
\ et J
<None Set>

<None Set>
[] Capture Audio and Videa to Separate Files
Waveform Cache: ( Set.. )  53.3GBon lacie 120gb#9:FinalCutPro:Videol
Thumbnail Cache: ( Set... )  53.3GBon lacie 120gb#9:FinalCutPro:Videol
Autosave Vault: ( Set.. )  53.3GBon lacie 120gb#9:FinalCutPro:Videol
Minimum Allowable Free Space On Scratch Disks: 2047 MB

(") Limit Capture/Export File Segment Size To: MB
(7 Limit Capture Now To: Minutes

This is also a good place to set or unset the “Limit Capture Now” option (the final line in
the “Scratch Disks” tab.) This refers to the amount of time Final Cut Pro will import your
footage during Log and Capture. Importing footage (from VHS, DVD, mini-DV, or a live
feed) occurs in real time, so you may not want to pay close attention if your video is longer
than a few minutes. Setting the “Limit Capture Now” will set a timeframe for Log and

Capture — anywhere from 1 to 240 minutes. Setting the timeframe will prevent Final Cut
Pro from importing unnecessary footage — and thus taking up precious harddrive space. For
example, if you have a 1-hour tape, you can set the limit to 64 minutes (60 minutes plus 4
additional minutes to be safe), begin the Capture Now process (in Log and Capture), and
then leave and return several hours later. Instead of capturing until your scratch disk is filled,
Final Cut Pro stops capturing after 64 minutes.

Familiarizing yourself with the Final Cut Pro Workspace

Before you begin actual work on your project, you will find it useful to familiarize yourself
with the work environment of Final Cut Pro. This section will help you to get a basic feel for
what you see on your screen.

When you open a new Project in Final Cut Pro, your screen should look like the image
below. If it looks substantially different, from the toolbar, select "Window" = “Arrange” =
“Standard.” (There are a few other options for window arrangement. Test these out as you
like.” You can use this command at any time to revert the windows to any of the listed
arrangement.

Based on their arrangements in “Standard,” each of the windows is described briefly below.



The Windows in Standard Arrangement
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Browser Window

The Browser window is located in the upper left corner. The Browser contains all the media,
Sequences, and Bins for your Final Cut Pro project. After you set your System Settings and
save your project with a name, the other tab should be labeled with the name of your
project. This tab is where you can gain quick access to your video and audio files as well as

your Sequences.
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Viewer Window

The Viewer window is used to preview and edit individual Clips from the Browser. Make
imaging and sound edits to Clips in the Viewer. To change Effects that you have already
added to a Clip (see pages 15 — 18 for video effecss, 22 — 23 for audio effects) look under the

“Filter” tab. To change the image location, opacity, scale, etc. look under the “Motion” tab.



Double-click on a clip in the Browser to make it appear in the Viewer. Make sure that you
have selected the Clip you want to edit by checking the “Video” tab in the upper left corner.
The Viewer and to the Canvas do not necessarily display the same footage. If you want to
see the changes you are making in the Viewer, set the Playhead in the Timeline to the same
place as your selected clip.

Canvas Window

When you play your Timeline, it plays in the Canvas window. You cannot edit video or
audio in the Canvas window.

Toolbar
Use the toolbar to locate all editing functions for Final Cut Pro.

Timeline Window
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The Timeline displays a chronological view of an open Sequence. A Sequence is what Final
Cut Pro calls the compilation of edits for your project in one Timeline. Each Sequence has
its own tab in the Timeline. Notice that your Timeline says “Sequence 1.” If you would like
to title the Sequence, double-click “Sequence 1” in the Browser and enter a name. To add
new Sequences, either select, from the toolbar, “File” =2 “New” = “Sequence” or Control-
click the Browser and select “New Sequence.” (Use these same processes to add new Bins.)

You can use the Timeline to edit and arrange a Sequence. The order of the tracks in the
Timeline determines the layering order when you combine multiple tracks of video. Changes
you make to a Sequence in the Timeline are seen when you play back that sequence in the
Canvas. If you modify clips in the Canvas, those changes can be seen in the Timeline. The
Timeline is divided in two. The top half displays Video files; the bottom half displays Audio
files.



Familiarize yourself with the two symbols in the upper right corner of the Timeline.

When either function is active, it turns green. Activate by clicking the icon once. “Linked
Selection” sutures the video and audio files in your timeline. In other words, when you move
the video file, the audio file follows — and vice versa. When you want to delete either the
video or audio portion of a Clip, it is important that “Linked Selection” is off. “Snapping”
enables more precise Clip movement in your Timeline. Test it out by moving clips around
on your timeline and see the difference.

Tool Palette

This window contains various tools that you can use to edit your project. The most helpful
and commonly used tools are the “Selection tool” — an arrow, the “Razor Blade tool” —a
razorblade, and the “Zoom tool” — a magnifying glass. Select these by clicking them once, or
using their keyboard shortcuts when nothing else in your project is selected. (To learn more
keyboard shortcuts for the tool palette, rest your mouse over the tool’s icon. A yellow
window will appear giving the tool’s name and shortcut.)
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Final Cut Pro defaults to the “Selection tool” (keyboard shortcut “a”), which is used to
select Clips. To select more than one Clip at a time, hold the shift key while selecting.

Use the “Razor Blade tool” (keyboard shortcut “b”) to cut your Clips.

Notice that the “Razor Blade tool” has a tiny arrow in the upper right corner of its icon.
This indicates that there are more options within the tool. To access these, either click the
icon and hold the mouse down for a second or press the Command key while clicking the
icon. The double razor blade icon signifies the “Razor Blade all tool” (keyboard shortcut
“bb”). Use this when you want to cut Clips that rest in several tracks on your Timeline.

The “Zoom tool” (keyboard shortcut “2”) to zoom in or out. Final Cut Pro defaults the
“Zoom tool” to in, but if you press the Option key while holding down the mouse. You can
also access the zoom out by Command-clicking the “Zoom tool” in the Tool Palette. You



will also see a hand icon. This is useful for looking quickly through your timeline. The
keyboard shortcut for the “Hand tool” is “h.”

Audio Meters

Use this window to monitor the level of your audio output. If nothing happens in these
meters when you play your video it means that you either do not have an audio track, or
your audio is too quiet. If the dark red circle turns bright red, your audio is too loud. Edit
audio clips in the Viewer like you would a video clip.



Importing Media into your Final Cut Pro Project
Usable Formats / Importing Video / Importing Audio / Log and Capture

Log and Capture

Log and Capture is used to import video or audio from a non-computer source, such as
VHS, mini-DV, DVD, live stream, or an Audio Cassette. (In other words, use this to get the
video you have shot on camera onto the computer.) First, make sure that you have set your
System Settings properly. Next, turn your device on or, if importing from a camera, that it is
both on and set to the “Playback” mode. Then, find the Log and Capture function from the
toolbar: Select “File” = “Log and Capture.” This will open the Log and Capture window,
which should look like the image below.

If you get a warning that says “Unable to initialize video deck. You may still log offline clips
or use Capture Now,” but you have a deck/device properly connected, you need to help
thecomputer locate the deck. First try: (from the toolbar) “View” = “Refresh A/V Devices.”
If this does not work, you need to reset your A/V devices. From the toolbar: “Final Cut Pro”
- “Audio/Visual Settings” Under “Device Control Preset” select “FireWire NTSC.” If you
are importing from a VHS deck or other Analog Device, select “Non-Controllable Device.”

Audio/Video Settings

Summary | Sequence Presets | Capture Presets | Device Control Presets \ A/V Devices

Sequence Preset: | DV NTSC 48 kHz ﬂ
Use this preset when editing with DV NTSC material with audio set to 48KHz (16bit for DV).
Capture Preset: | DV NTSC 48 kHz ]
Use this preset when capturing NTSC material for DV FireWire input and output using DV FireWire.
Device Control Preset: | FireWire NTSC B
Use this preset when controlling your NTSC DV device through FireWire.
Video Playback: | [Missing] Apple FireWire NTSC (720 x 480) 7]
Audio Playback: | Default )
( Create Fasv Setun. )
Create Easy Setup... y
K. Cancel 1

Within Log and Capture, you can title the media you are importing from the “Logging” tab.
Name the media within the “Description” line. You can get even more specific by labeling

“Scene,” “Shot/Take,” “Angle,” and “Log Note.”
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After your clip is labeled, press "Play" on your device or in the Log and Capture window.
Then click the "Now" button on the bottom right of the Log and Capture window. A new
window will open and Final Cut Pro will begin to capture the media. Because capture is in
real-time, if you shot 2 hours of footage, you need to wait 2 hours for the capture to

complete.

While capturing, it is a good idea to leave the computer alone. In other words, do not
surf the Internet, or use a program that uses the computer’s graphics card (Photoshop.
Dreamweaver, Flash, etc.).

You can either wait around for your media to capture, or you can return to the computer
when you think it has finished importing your media. You can also set the Limit Capture
Now, as described in the Glossary to this booklet.

When the clip you want has finished, stop capturing by hitting the Esc key. Final Cut Pro
will automatically save the clip you just captured into the Browser. Final Cut Pro also keeps
a copy of your original captured media in your Home Directory’s “Capture Scratch” folder.
If you ever cannot find the original media, you can look through this folder. Here is where
naming your logged clips comes in handy.

If, while capturing, your tape stalls, and the window says that Final Cut Pro is searching
for “Timecode,” press Escape. Ignore the error message that pops up. Now, Set up Log
and Capture again as before.

Usable Formats

Final Cut Pro can import the following formats:

Video files:
QuickTime Movie, AVI, DV, HDV.

Audio files:

11



AIFF/AIFC, WAVE. (You can convert mp3’s to make them compatible in iTunes or
Quicktime. To prevent this extra step, follow the guidelines for importing CDs through iTunes on
pages 25 & 26.)

Graphics and still images:
BMP, FlashPix, GIF, JPEG/JFIF, MacPaint (PNTG), Photoshop (layered), PICS, PICT,
PNG, QuickTime Image File, SGI, TARGA (TGA), and TIFF.

Importing Video: From pre-existing files.

You can import video files into Final Cut Pro in a number of ways. But, always be certain
that you first save the file to your Home Directory so that it is always stored in your
project correctly. You can drag your clip into the Browser from your Home Directory. (The
easiest way is to open a Finder window, navigate to your Home Directory, drag and drop
into Final Cut Pro.) You may also import from within the program: From the toolbar “File”
—> “Import” = "Files.” You can select several files at a time, but if you have a whole folder
to import, you can select “File” = “Import” = “Folder.” You might also try this shortcut:
Control-click your mouse in the Browser and select “Import” from the window that pops

up. If you are organizing media into Bins in the Browser, you can Control-click the Bin and
import directly into the bin.

Importing Video: From VHS, mini-DV, DVD, or live stream.
If you need to get video from a VHS, mini-DV, DVD or live stream use “Log and Capture”

(see pages 10 — 11 to learn about Log and Capture). Be sure to double check that your
System Settings are properly set before you initialize Log and Capture.

Importing Audio: From pre-existing files.

Import audio in the same way that you import video. Again: always be certain that you
first save the file to your Home Directory so that it is always stored in your project
correctly.

To import music from a CD, it is easiest to use iTunes (see pages 25 — 26 for iTunes
instructions) to import the audio and reformat it appropriately. Once you have the audio file,
move it into your project folder. Then drag it into the Final Cut Pro Browser or import it
using an "Import" command.

Importing Audio: From VHS, mini-DV, DVD, live stream or Audio Cassette.
If you need to get audio from a VHS, mini-DV, DVD, live stream or Audio Cassette use

“Log and Capture" (see pages 10 — 11 to learn about Log and Capture). Be sure to double
check that your System Settings are properly set before you initialize Log and Capture.

12



Editing and Assembling Your Video
Editing Video with In and Out Points / Editing Video Directly in the Timeline / Adding Tracks /
Locking Tracks / Adding Effects / Using Video Generators: Text & Slugs / Rendering / Keyframing
/ Editing Audio Directly in the Timeline / Editing Audio with the Viewer / Voice Over / Using
Audio Transitions & Effects | Working with Sequences

Once you have your audio and video clips imported into Final Cut Pro, you are ready to
begin editing them and assembling them into a cohesive project.

In this section, you will learn the two basic ways to edit your media files into clips.

The first (Editing in the Viewer) is less visually minded. The second (Editing Directly in the
Timeline) is much more visual.

Editing Video in the Viewer
Here is the basic order of operations:

Double-click on the media file in the Browser.

This will cause the media to appear in the Viewer.
Edit the Clip in the Viewer using In and Out Points.
Drag the Clip from the Viewer into the Timeline.

Use the Canvas to view your video from the Timeline.

NN RS

When editing in the Viewer, you need to set In and Out Points. In and Out Points define at
what point you want a Clip to start and at what point you want a Clip to end. To set In and
Out Points for a Clip, first get the Clip into the Viewer by double-clicking on the Clip in
the Browser. Your Clip should appear in the Viewer, and you can watch it using the "Play”
button.

[s7aTal Viewer: 003 in Video

Video | Filters | Motion | J

®, 00:00:12;20 86% B €3 [ 00042217
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Now, move the Playhead to where you want the Clip to start. Click on the “In” button or
press the "i" key. You will see the "In" marker move to where the playhead is. Now move
the Playhead to where you want your video to end. Click on the “Out” button or press the
"0" key. The "Out" marker should move to where the Playhead is.

Viewer: 003 in Video

f'3 oo‘ao 02; 13A &%y WY 09

Now, click on the Viewer and drag your clip onto the Timeline. Notice that what has been
gy
placed onto the Timeline is only the area in between the "In" and "Out" markers.
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You can drag the clips in the Timeline to rearrange them. Note that the top half of the
Timeline is your video track and the bottom half of the Timeline displays your audio tracks.

To watch the edits you have made, place the Playhead at the beginning of your Clip and
press the space bar. It will now play in the Canvas.

Setting In and Out points does not permanently change your media. This means that
you can create clips in the Viewer by setting In and Out points and dragging them into the

14



Timeline ad infinitum. Thus, you can use multiple clips of the same imported video or audio
file in the same Sequence or Timeline.

Editing Video Directly in the Timeline
Here is the basic order of operations:

Double-click on the media file in the Browser and drag it into your Timeline.
Your media will appear in the Viewer.

Edit the Clip in the Timeline using the “Razor tool”and the Playhead.
Arrange your Clip or Clips as you like in the Timeline.

Use the Canvas to view your video from the Timeline.

RANIN .

When editing directly in the Timeline, you start with a copy of your original media file. Your
Timeline will be as long, in terms of time, as the original file.

Double-click the media file in the Browser and drag it into your Timeline. Your Playhead
will move to the end of the file. Navigate through your media by either dragging the
Playhead along the top of the Timeline, dragging the bars at the bottom left of the Timeline
(see page 7 for an illustration), or using the “Zoom” or “Hand” tools (see pages 8 — 9 for ool
palette information).

Once you have found a place you want to cut material out, find the “Razor tool” in the
Tool Palette. Click the file with the “Razor tool.” (If you are working with Captured
material, you may want to get rid of excess material first.) It will make a divide in the

original file: aka a Clip. Now you can move the two Clips independently.
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Arrange your Clips on your Timeline. Move the Playhead to the beginning of your edited
material and press the space bar to view the video in the Canvas (or listen to the audio.)

Adding Tracks
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It is very easy to add tracks to your Timeline. Adding more tracks enables visual or aural
layering. To add a track, simply Control-click in the panel and select “Add Track.” Click in
the Video half to add video tracks, the Audio half to add audio tracks.

Locking Tracks

When editing, you may want to keep some tracks “as is” and move others around. Final Cut
Pro allows you to lock both Video and Audio tracks. Simply click the lock icon in the panel.
To unlock, click it again. Locked tracks have hash marks through them.

Sequence 1
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Adding Video Effects

Final Cut Pro's video Effects include filters and transitions. Effects can be found under the
"Effects" tab in the Browser or along the toolbar. Note that there are a number of folders,
each one containing a number of different effects. You will also see Audio Effects here, but
for now, we will focus on the Video Effects folders: Video Transitions and Video Filters. See

pages 25 — 27 10 learn abour Audio Effects.
*  Video Filters apply to an entire clip; they range from very subtle (such as "Color
Correction" effects) to extreme (such as the "Blur" effects).

* Video Transitions provide different ways to transition from one clip to another.

Also included when Effects is tabbed in the Browser, but not necessarily an Effect:

16



* Video Generators create such things as color bars, slugs and text. (These are also
located in the lower right corner of the Viewer by selecting the “A” icon. (€=P)

When you select an Effect (from either the tab or the toolbar), first have the Clip you wish
to affect selected and active in the Viewer (in other words, double click it!). Then, choose
your Effect and drag it over to the Viewer of your selected clip. In most cases, the Effect will
now be located in the “Filters” tab of the Viewer. Adjust the parameters for the Effect to
your liking. Every Effect is different; the best way to learn them is to experiment. Make sure

that the Playhead is also over the Clip you are effecting so that you can see what the Effect is
doing,

Viewer: 003 from Sequence 1

Nav f. ovo1'22:02
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Transitions are a bit different in that they need to be dragged to the Timeline in between
two Clips or a Clip and a Slug. Transitions are actually visible on the Timeline. You can
change the length of the transition by dragging from its start or beginning.

@ Final CutPro_File Edit View Mark Modify fects_ Tools 9O 4 Do Thullldam Q
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Using Video Generators: Text and Slugs

Use Video Generators to create Titles, Slugs, Color Mattes, and Color Bars. Generators
create their own Clip, so you will set timing parameters to them.
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Titles are text that appears over the top of a video clip. There are a few different types of
Titles available through Final Cut Pro (for more ambitious Titles, try the program
LiveType). “Text” is the most straightforward, but “Scrolling Text,” and “Crawl” are also
quite common.

From the Browser or the Viewer, find the “Text” folder. Once you have selected a text
generator, double-click it and it will appear in the Viewer. Now, select the “Controls” tab to
insert text, and choose a font. For greater manipulation of the text, choose the “Motion”

tab.

Final Cut Pro does not handle text very well — and even though there are many options for
fonts, relatively few will actually look good on screen.

Tips on Optimizing Text for Titles

* Avoid fonts that are thin or smaller than 25 point.
*  Use only sans serif fonts, such as:

* Arial

* Futura

e Gill Sans
e Helvetica
* Impact

*  Use the bold font style.

* Do not use white or black as a font color.

* Reduce the opacity of the text clip to 90 percent. (Look in the “Motion” tab in the
“Viewer” for this.)

You may also want to make Slugs with the Video Generator. Slugs are“filler” video and
audio clips with no image and no sound. Slugs are useful to preserve time in your Sequence
for future material. Also slugs are necessary to add transitions to black. They are generated
by selecting the “A” icon in the lower right corner of the Viewer: M3 You can adjust the
timing of the Slug in the upper left corner of the Viewer. Drag and drop the Slug into your
Timeline.

Rendering
You may have noticed that when you insert or apply a Video Filter, Transition, or Generator
there is often a red or a green line that appears in the Timeline. When this red line is

present, you cannot watch that part of your project. That is because you need to Render
your effect.
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Rendering is the procedure that Final Cut Pro must execute for processes that cannot be
completed in real time before they can be viewed; if a Sequence needs Rendering, there will
be a red line at the top of the Timeline and you will not be able to view the project until the
sequence has been rendered. When there is a green line above the clip you can still watch or
listen to the Clip, but you will need to render the clip to optimize the image and sound
quality. To Render, select the portion that needs rendering (unless you want to render your
entire Sequence, in which case nothing needs to be selected) select “Sequence” = “Render
In to Out” or “Render All” or “Render Selected.”

Depending on the length and complexity of your effect, this may take quite a while.
Keyframing

Keyframes are definitely one of the best ways for you to control changes in your Final Cut
Pro project, so try them out! Keyframes are a special-purpose control that denotes a change
in value in a filter or motion parameter. When two Keyframes with different values are set in
Final Cut Pro, a transition from one value to another is calculated, resulting in a dynamic
change to that parameter. For example, Keyframes can be set to create fade-in or fade-out in
video. Similarly, Keyframes may be used in audio files to create fades. The easiest way to set
keyframes is in the Viewer: look under the “Motion” tab for Video or the “Stereo” tab for
Audio. Audio keyframes can also be set in the Timeline using the “Toggle Clips Overlay”
and “Pen tool” buttons. See pages 8 — 9 for wol palette information.

Keyframes are small diamond shaped buttons.

When unactive, keyframes look like this:

When active, keyframes look like this:
You don’t need to use Keyframes if you want a CONSTANT change. In that case, just set
the scale, Effect, etc. to a specific number. Keyframes designate points where you want a

CHANGING Effect, motion, scale, position, audio level etc. to begin. When you set a
Keyframe, set a second Keyframe at another point in time to designate its end point.

An example of unselected Keyframes in a Video file:
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Now selected, and with two Keyframes. Notice the transition (the green line between them):

Viewer: 003 from Sequence 1

Nam Parameters Nav 1:02:32:04 01:02:40,04
¥ Basic Motion ® =
saal iy, [ 272| A@b |
(1,, 2
Cent ®r . ¢ @
Anchor Point 0. o 1@
» Crop ® =
» Distort ® =
> Opacity ® =
> Drop Shadow ® =
> Motionsl ®
» Time Remap 1©)

Editing Audio Directly in the Timeline

Now that you are familiar with how to work with video in the Timeline, we can quickly go
over audio. If the only audio that you want to use is the audio that is connected to your
video, there is nothing special that you have to do — it should automatically be attached to
your video clip. If you want to add music or sound effects, save them to your Home
Directory and import them into the Browser (see pages 11 — 12 for Importing

information). Then, from the Browser, drag the audio clips to the bottom half of the

Timeline. It is much easier to adjust audio by editing the directly in the Timeline than using
In and Out points from the Viewer.

Once your audio files are in the Timeline, locate the “Toggle Clip Overlays” icon ]Min
the lower left corner. Once you select this, overlay lines will appear on both your audio and
video files in the Timeline. The overlay lines will be pink for audio and black for video.
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Next, turn on the waveforms for the audio. From the toolbar, select “Sequence” =
“Settings.” A window will pop up. Select the “Timeline” tab and check the box next to
« . »

Show Audio Waveforms.

Name Plus Thumbnail =
Sequential (AL, A2, A3, A4) '+]

D ——

Your audio track will now display both the pink overlay line and the waveforms. Zoom into
the track to get a closer look.

Rest the tip of your cursor on the pink overlay line. The pointer will turn a double arrow:

. Click the mouse and, while holding, drag the pink line up or down. This will move the
will raise or lower your audio volume. As you do this, a window will show the amount of
increase or decrease of your volume in decibals (dBs). When you first click you will see that
0 shows in the small box. This is the starting or reference point for the audio of this clip.
Your changes will show as + or - dBs. The maximum increase will be + 12 dBs. - 60 dBs will
be no audio. If you wish to return to your original volume setting click on the overlay line
and drag until the little box shows 0. The changes that you make this way will effect the
volume of the entire clip. If you are working with a stereo pair, any change you make to one
channel will affect the other. If you are working with two mono tracks, you will need to
repeat the same level changes to the second track.
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You may also change the audio levels in only one part of the Clip. To do this, you will mark
Keyframes on the pink overlay. From the tool palette click on the pen icon; this activates the
“Pen tool” (keyboard shortcut “p”). Select the part of the line where you want to add a
Keyframe.

When setting Keyframes, set one that “saves” the original audio volume. Then set another
for a new audio volume. If there is any space in between your Keyframes, Final Cut Pro will
create a transition between them.

=003 003 —
== 2
=

AM drive. MP3

v

AM drive MP3 -
= = A %Wﬂ

Once you have set your Keyframes you can move them left or right with your mouse. To
remove a Keyframe, either press Control while selecting it with the “Pen tool” or hold down
the Option key while selecting with the “Pen tool.”

You can also use this technique to fade your audio up or down at the start or end of a Clip.
In video, this technique will affect the opacity of the image. Use this technique for fading in
or fading out image.

See pages 15 — 16 for instructions on adding tracks and locking tracks.

Editing Audio in the Viewer

Everything that has been outlined here can be done in the Viewer, where very precise
work may be done. Try a different Window layout if you choose to edit audio this way.
From the toolbar, select “Window” = “Arrange” = “Two Up.”

Using Audio Transitions & Effects

Just like with video, there are a number of Effects offered by Final Cut Pro that can be
applied to your audio. These can be applied in the same way that video effects are applied;

just drag the effect from the Browser window onto the audio track. Double-clicking the
effect lets you adjust the parameters in the Viewer.
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Audio Filters remove certain parts of the sound spectrum and can be used to try and
reduce background noise. There are also some that can be used for more dramatic
effects ("delay" for example).

Audio Transitions can be used to create smooth audio transitions between Clips.

When you select an Effect (from either the tab or the toolbar), first have the Clip you wish
to affect selected and active in the Viewer (in other words, double click it!). Then, choose
your Effect and drag it over to the Viewer of your selected clip. In most cases, the Effect will
now be located in the “Filters” tab of the Viewer. Adjust the parameters for the Effect to
your liking. Every Effect is different; the best way to learn them is to experiment. Make sure

that the Playhead is also over the Clip you are effecting so that you can see what the Effect is
doing,

000 Viewer: AM_drive.MP3 from Sequence 1
Stereo (ala2) ' Filters
Name Parameters Nav 00 0112'00;22 0132
¥ Stereo 1 Filters
¥ W AUDelay ® =v :
dry/wet mix ——t— 50 o)
delay time e 1
feedback e | so| 400
lowpass cutoff fraqu[«=-——————(» 15000 )

R mmrom mp

Transitions are a bit different in that they need to be dragged to the Timeline in between
two Clips or a Clip and a Slug. See pages 16 — 18 for Slug information. Transitions are actually
visible on the Timeline. The only Audio Transition available in Final Cut Pro is “Cross Fade
(0dB)” or “Cross Fade (+3dB)” => the difference being the volume of the fade. To add a
Cross Fade, select the junction between two audio Clips or a Clip and a Slug. Then drag and
drop the Cross Fade onto that space. It is easiest to work with Cross Fades if you are
zoomed into the Clips. Use the “Zoom tool” or the bar on the bottom of the Timeline.

Note: You can make Cross Fades using the Audio Editing technique detailed on pages
23 - 24.

Select the Junction between two Clips:
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Add the Transition:

Unlike Video Transitions, you can only tweek the timing of a Cross Fade. Either drag the
Cross Fade in the Timeline from its start or end or double click the Cross Fade and enter a
duration.

You will need to Render after adding an Effect, as well. See page 21 for Rendering information.
To Render, select the portion that needs rendering (unless you want to render your entire

Sequence, in which case nothing needs to be selected) select “Sequence” = “Render In to
Out” or “Render All” or “Render Selected.”

Working with Sequences

If you are working on a complicated or lengthy project, you may consider working with
Sequences. By adding new Sequences (see pages 6 — 7 for Sequence information) you create
separate editing areas in the Timeline. This is helpful if you want to try new types of edits,
but want to keep an original idea, or if you want to work on different places (or scenes) in
your project. It is a good idea to name your Sequences.

In addition, Final Cut Pro allows you to “nest” Sequences. In other words, every Sequence
listed in your Browser may be dragged and dropped into a new Sequence. It is then treated
as a complete file (like all your Imported and/or Log and Captured material).
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Using iTunes to Import Music to Final Cut Pro

If you want to get music offa CD so you can add it to your Final Cut Pro project, or if you
want to simply make a copy of that CD, you need to first get the music off the CD and onto
the computer. Please follow these instructions prior to importing your CD.

Many computers set iTunes to automatically import CDs. As such, please change the
following settings before inserting your CD.

First, set iTunes to import to your Home Directory. From the Menu bar select “iTunes” =
“Preferences.” In the window that appears, select the “Advanced” tab. Change the iTunes
library to your Home Directory. Create a new Music folder within that directory.

i JER—— T p——

o BE &H L

General Playback Sharing Store Parental Apple TV Devices Advanced

iTunes Music folder location
lacie 120gb#9:FinalCutPro:itunes_music: Change...
Reset

¥ Keep iTunes Music folder organized
Places files into album and artist folders, and names the files based on
the disc number, track number, and the song title.

™ Copy files to iTunes Music folder when adding to library

Use iTunes for Internet playback: Set )

Reset all dialog warnings: ( Reset )

[ Keep MiniPlayer on top of all other windows
[ Keep movie window on top of all other windows
[ Display visualizer full screen

|

|

|

|

|

|

|

‘ Streaming Buffer Size: [ Medium |
|

|

|

|

|

| ™ Group compilations when browsing
|

Cancel OK

Second, set iTunes to display a prompt before importing a CD. From this window, select
“General.” Make sure it says “Ask to Import CD.”

General

o BE K L

General Playback Sharing Store Parental Apple TV Devices Advanced

Library Name: Sara Blaylock’s Library

Show: ¥ Movies (") Applications
™ TV Shows ™ Radio
™ Podcasts ™ Party Shuffle
[ Audiobooks [ Ringtones
™ Genius
Source Text: [ Small 4] List Text: [ Small |4
When you insert a CD: | Ask To Import CD %] (Import Settings...

™ Automatically retrieve CD track names from Internet

M Check for new software updates automatically

Cancel oK

From here, you can also change the encoding settings for the audio files you want to import.
Final Cut Pro can only use AIFF/AIFC or WAVE files. Select “Import Settings” (to the right
of “Ask to Import CD.” In the new window, select either “AIFF Encoder” or “WAV
Encoder”.
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General

e BE N [

General Plavback Sharina Store Parental Aoole TV Devices Advanced

Import Settings
AAC Encoder
Import Using v AIFF Encoder 3
Apple Lossless Encoder g
Setting  Mp3 Encoder B
WAV Encoder
All automatic.
[ Use error correction when reading Audio CDs
Use this option if you experience problems with the
audio quality from Audio CDs. This may reduce the
speed of importing.
Note: These settings do not apply to songs
downloaded from the iTunes Store.
("Cancel ) (0K )
= e

Now you can insert your CD. If the CD is an original or a copied original, iT'unes will
provide track names within a few seconds. If it is a mix CD or a copy of random audio tracks
and you want track names, you will need to import names manually. Say “No” to the
“Would you like to import the CD...” window prompt. Simply highlight the track, click the

title once and enter your title.

If you only wish to import a few of the tracks on your CD, unselect the blue checkmark next
to unwanted titles. You can also choose to import a partial track. Prior to importing, select
the track and then go to “File” = “Get Info.” In the window that opens, select the
“Options” tab and set a Start and Stop time.

[ start Time: [0:00

[ Stop Time: 2:33.066

(“previous Next [3

RN 10 songs, 40.7 minutes, 412.1 M8, import D

Now you can import your CD, assured that it is saving to your Home Directory and in a
Final Cut Pro compatible format. Import the files as you would any other media file. See
pages 11 — 12 for Importing information.
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Finishing Your Project
Exporting Your Movie: DVD, Computer, Internet / Recording to VHS or miniDV tape

Exporting Your Movie

In order for your Final Cut Pro project to become a movie (or audio file, as the case may be)
that can be played on a computer, a DVD player, or the Internet you need to export. To
export, set In and Out Points and from the toolbar select “File” = “Export.” Now is when
you get to decide what Codec you want to use for compression. Exporting will compress
your file, so set it to the highest quality permitted for your Output device (DVD, computer,
Internet). You can always work backward, but you can never add quality to a compressed
file. Always export these files with unique names and to a unique “Export” folder in your
Home Directory.

Exporting Your Movie: for DVD.

If you are exporting simply to edit within Final Cut Pro or to make a DVD, you can select
“Export” = “QuickTime Movie.” Make sure that the “Make Movie Self-Contained” box is
selected. Exporting like this will not take as long as using a unique Codec. This is because it

is leaving the Compression up to the DVD production software.

N u®, Save
Save As: Video_OOl‘ @
RIEEN! | (] exports W Q
DEVICES
- Macinto...
| iDisk

L lacie... &
A n
SHARED v

o

Setting: | Current Settings
Include: | Audio and Video
Markers: | None

"1 Recompress All Frames
¥ Make Movie Self-Contained

f ion  (New Folder™) Ccancel>) (RS
Iz‘ Hide extension New Folder Cancel Save

“

»

v

Exporting Your Movie: for Computer Playback.

When playing back on a computer, you have more control over the output size and quality.
From the toolbar, choose “File” = “Export” = “using QuickTime Conversion.” Select
“Options” and a window with a new window appears. Select a Codec from the dropdown
menu. The best quality for computer playback is “H.264.” Deselect the “Prepare for
Internet Streaming” box.
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After selecting “Options” choose H.264.:

Movie Settings.

| ~™ Video

1!
| (Settings... ) Compression: H.264
————— Quality Kigh
Key frame rate: 24
=

(_Filter.. ) Frame reordering: yes

< Encoding mode: multi-pass
Size... Dimensions: 557x417 (Current)

<>

DEVICES
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B awt Sample size: 16-bit
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Format: | @ ~[_!Prepare for Internet Streaming

Dy
V' Hide exts (Cancel ) ok ) [ Save

You can try out other Codecs as you learn about them online. The best way to tell if your
exported file is of high quality is if it takes a long time to export. Additionally, the resulting
file should be big — both in terms of memory and physically. Open it up in QuickTime Pro.
If the initial window is large, you have a good sized file that you can play on a computer (or
make smaller as needed). Another way to tell is by playing back in QuickTime at fullscreen.
If your text is very blurry, go back to Final Cut Pro and try exporting again. Remember,
exporting takes a very long time. So plan ahead!

Exporting Your Movie: for the Internet.

When exporting for the Internet, you will need to prepare the movie as either a QuickTime
“Fast Start” or “Hinted Streaming.” “Fast Start” means that the movie will start playing
from a web server before the movie has completely downloaded to the user’s hard disk. In
other words, it will play even though it has not completely loaded. When preparing with
“Hinted Streaming” you decide the data rate at which the movie will download. You
probably won’t use “Hinted Streaming.”

When exporting, use the H.264 Codec recommended for Computer playback. When

choosing this (see page 27 for more Codec information) make sure the “Prepare for Internet
Streaming” box is checked, and that it says “Fast Start.”
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Recording to VHS or miniDV tape

If you are going to export your video directly onto a VHS or miniDV tape, you can either
Print to Video or Edit to Tape. Both will happen in real-time.

Print to Video offers you more options. Find this by selecting “File” in the toolbar, and then
“Print to Video.” Here you can choose to add a “Leader” (some bit of black, color bars, or a
tone that precedes your project) or a “Trailer” (some bit of black that follows your project).
There are a few other choices available, like setting looping intervals. Print to Video gives

you more options than Edit to Tape.

Print to Video

" Leader
Element: Sec:
[ Color Bars - [ 60 — Tone Level «~~‘(y—[-12 d8
[) Black 10
[ Slate 10— [ ClipName |§
(] Black 10
("] Countdown (Built-in :
Media Trailer
Print: [ In to Qut v W Black 5 Seconds
Options:
Duration Calculator
) Loop 1 Times
Media:
Between each loop place: eca:
() Black 5 Seconds Total:
) Automatically Start Recording
L}
(G ) (oK)
\_

Edit to Tape connects your Timeline directly to a VHS or mini-DV deck. You will not have
the option of setting a “Leader,” “Trailer,” or “Color Bars.” Find this by selecting “File” in
the toolbar, and then “Edit to Tape.” Make sure you have a VHS or mini-DV deck set up.
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Final Cut Pro Glossary

Underlined items are cross-referenced in this glossary. Please also refer to the Final Cut Pro User Manual Glossary.
To find this, from the toolbar select “Help” = “Final Cut Pro User Manual,” then search for “Glossary.”

A

B

Batch Cap ture: an automated capture of clips that are logged using the Logand Capture function.

Bin: located in your Browser window, use bins like folders to organize your media. You can have as
many bins as you like. You may name and add bins in the Browser. There are two ways to add ne bins:

from the toolbar, select “File” > “New” 2 “Sequence” or Command-Click in the Browser and select
“New Sequence.”You can import specific files to specific bins. For example, import all your audio files
into one Bin and call it “Audio.” This is useful when you use a lot of different media for your Project.

Browser: The Browser contains all the media, Sequences, and Bins for your Final Cut Pro project.

Canvas: The canvas is a viewer connected to your Timeline. It displays where the Playhead is set.
Compare this with the Viewer.

Capturing: In order to use DV tapes, VHS, DVD, or live footage, you need to capture them into your
project. This differs from import in that you must capture in real time, and with a tape deck, dvd deck,
camera, etc connected to your computer. Because capture is in real-time, if you shot 2 hours of footage,
you need to wait 2 hours for the capture to complete. Capture takes place in Log and Capture.

Clip: a portion of an audio orvideo file that you are editing,

Codec: The name "codec" is short for "coder-decoder," which is pretty much what a codec does. Most
audio and video formats use some sort of compression so that they don't take up a ridiculous amount of
disk space. Audio and video files are compressed with a certain codec when they are saved and then
decompressed by the codec when they are played back. Common codecs include MPEG and AV for
video files and WAV and AIFF for audio files. Codecs can also be used to compress streaming media (live
audio and video), which makes it possible to broadcast a live audio orvideo clip over a broadband
Internet connection.

Compositing: When you composite, you are placing two images on top of one another in your
Timeline. Compositing is most often used to overlay images— perhaps you want to place some footage of
ducks swimming on top of footage of a pond. There are many different methods of compositing, with
differing effects. Select the image you want to composite, then (from the toolbar) select “Modify” >
“Composite Mode.”

Edit to Tape: Instead of Exporting your Final Cut Pro project, you can copy it straight to a video tape,
mini-DV tape, or other source with the “Edit to Tape” function. Find this by selecting “File” in the
toolbar, and then “Edit to Tape.” For more options (like setting leaders and trailers), choose Print to
Video.

Effects: Final Cut Pro's effects include video filters, video transitions, audio filters, and audio
transitions. Effects can be found under the "Effects” tab in the Browser. Effects can also be found along
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the toolbar. When you select an effect (from either the tab or the toolbar), drag it over to the Viewer of
your selected clip.

Export: In order for your Final Cut Pro project to become a movie (or audio file, as the case may be)
that can be played on a computer, aDVD player, or the Internet, you need to export. To export, set In and
Out Points and from the toolbar select “File” 2 “Export.” Now is when you get to decide what Codec
you want to use for compression. Exporting will compress your file, so set it to the highest quality

necessary. You can always work backward, but you can never add quality to a compressed file. If you are
exporting simply to edit within Final Cut Pro or to make a DVD, you can select “Export” 2>
“QuickTime Movie.” Otherwise, choose “Export” 2 “using QuickTime Conversion” and select a
Codec from the dropdown menu. Always export these files with unique names and to a unique “Export”

folder in your Home Directory.

Home Directory: This is the folder where you will save your Final Cut Pro project, all the files you
use in your project, and anything you Export. You will also set your System Settings to link to your home
directory. This ensures that Final Cut Pro is saving Renders and Capture metadata. Best practice is to
create a separate folder for each Final Cut Pro project. This folder will then live within the “Final Cut Pro
Documents” folder that is automatically generated when you set your System Preferences when you start a
Final Cut Project. Get in the habit of saving everything to the home directory, and check your System
Settings everytime you open a project in Final Cut Pro.

In and Out Points: By setting in and out points, you can change when a clip begins and end; think
of "in" and "out" as "start" and "finish." This is important for editing and Exporting correctly.

Keyframe: A special-purpose control that denotes a change in value ina filter or motion parameter.
When two keyframes with different values are set in Final Cut Pro, a transition from one value to another
is calculated, resulting in a dynamic change to that parameter. For example, keyframes can be set to create
fade-in or fade-out in video. Similarly, keyframes may be used in audio files to create fades. The easiest
way to set keyframes is in the Viewer: look under the “Motion” tab for Video or the “Stereo” tab for
Audio. Audio keyframes can also be set in the Timeline using the “T'oggle Clips Overlay” and “Pen tool”
buttons. See pages 18 — 19 for more information.

Log and Capture: When Capturing video or audio from a mini-DV tape, DVD player, VHS tape,
Audio Cassette, or live stream, you use Log and Capture. First, make sure that your device is on or, if
importing from a camera, that it is both on and set to the “Playback” mode. Then, find the Logand
Capture function from the toolbar: Select “File” > “Logand Capture.” This will open the Logand
Capture window, which should look like the image below.
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If you get a warning that says “Unable to initialize video deck. You may still log offline clips or use
Capture Now,” but you have a deck/device propetly connected, you need to help thecomputer locate the
deck. First try: (from the toolbar) “View” = “Refresh A/V Devices.” If this does not work, you need to
reset your A/V devices. From the toolbar: “Final Cut Pro” = “Audio/Visual Settings” Under “Device
Control Preset” select “FireWire NTSC.” If you are importing from a VHS deck or other Analog device,
select “Non-Controllable Device.”

Within Logand Capture, you can title the media you are importing from the “Logging” tab. Name the
media within the “Description” line. You can get even more specific by labeling “Scene,” “Shot/Take,”
“Angle,” and “Log Note.”

Limit Capture Now: “Limit Capture Now” refers to the amount of time Final Cut Pro will import
your footage during Log and Capture. Importing footage (from VHS, DVD, mini-DV, or a live feed)
occurs in real time, so you may not want to pay close attention if your video is longer than a few minutes.
Setting the “Limit Capture Now” will set a timeframe for Logand Capture — anywhere from 1 to 240
minutes. Setting the timeframe will prevent Final Cut Pro from importing unnecessary footage, which
takes up precious harddrive space. If you do not set a “Limit Capture Now” preference, Final Cut Pro will
capture footage until your harddrive is full. For example, if you have a 1-hour tape, you can set the limit to
64 minutes (60 minutes plus 4 additional minutes to be safe), begin the Capture Now process, and then
leave and return several hours later. Instead of capturing until your scratch disk is filled, Final Cut Pro stops
capturing after 64 minutes. Set “Limit Capture Now” in System Settings. This can be found by clicking,
from the toolbar, “Final Cut Pro” = “System Settings.” In the window that pops up, look at the bottom
line of the first tab (“Scratch Disks”.)

Marker: A marker flags a specific point on your Timeline orina Clip so that you can find that spot
later. To create a marker on your Timeline, move the Playhead to where you want the marker, then press
"m" on the keyboard. To create a marker on your Clip, select the video or audio material and press “m.”

NTSC: This is the standard North American video format. Analog NTSC video has 525 interlaced
lines per frame, a frame rate 0f 29.97 fps, and a limited color gamut. Digital NTSC video has a frame size
of 720 x 486 pixels (720 x 480 for DV and DVD), and a frame rate of 29.97 fps. PAL is a different
standard that is not compatible with NTSC. It is possible, however, to import PAL media. You will need
both a universal VHS or DVD player and a media converter.

Offline Clip: An offline clip is one that the computer cannot locate. In this case, you either did not set
your System Settings correctly or you did not save your files to a unique Home Directory. You will see a
red slash through these clips in the Browser and you will be unable to see the clips in the Timeline. You
will need to relink the media by instructing the computer to search for it. Highlight the offline clip and,
from the toolbar, choose “File” 2 “Reconnect Media.” The computer will then search for the file. If it
cannot find the clip, you will lose all your edits! The easiest way to avoid offline clips is to save everything
in the same Home Directory and to set your System Settings every time you start editing in Final Cut Pro.
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PAL: Acronym for Phase Alternating Line, a 25 fps (625 lines per frame) interlaced video format used by
many European countries. Digital PAL video has a frame size of 720 x 576.

Playhead: This is the small, yellow triangle in the Timeline that corresponds to the frame displayed in
the Canvas and the Viewer. You drag the playhead to navigate through a Sequence.

Print to Video: Instead of Exporting your Final Cut Pro project, you can copy it straight to a video
tape, mini-DV tape, or other source with the Print to Video function. Find this by selecting “File” in the
toolbar, and then “Print to Video.” Here you can choose to add a “Leader” (some bit of black, color bars,
ora tone that precedes your project) ora “Trailer” (some bit of black that follows your project). There are
a few other choices available, like setting looping intervals. Print to Video gives you more options than

Edit to Tape.

Rendering: The procedure that Final Cut Pro must execute for processes that cannot be completed in
real time before they can be viewed; if a Sequence needs rendering, there will be a red line at the top of the
Timeline and you will not be able to view the project until the Sequence has been rendered. When there
isa green line above the Clip you can still watch or listen to the clip, but you will need to render the clip to
optimize the image and sound quality. To render, select the portion that needs rendering (unless you want
to render your entire Sequence, in which case nothing needs to be selected) select “Sequence” > “Render
In to Out” or “Render All” or “Render Selected.”

Sequence: An arranged series of video, audio, and graphics clips, edit information, and effects edited
together to create a program. A sequence can contain your entire edited program or be limited to a single
scene. You may name and add sequences in the Browser. From the toolbar, select “File” > “New” >
“Sequence” or Command-Click in the Browser and select “New Sequence.”

Slug: A “filler” video and audio clips with no image and no sound. Slugs are useful to preserve time in
your Sequence for future material. Also slugs are necessary to add transitions to black. They are generated

by selecting the “A” icon in the lower right corner of the Viewer: You can adjust the timing of the
Slug in the upper left corner of the Viewer. Drag and drop the Slug into your Timeline.

System Settings: It is absolutely essential that you set your system settings so that they direct Final
Cut Pro to save to a unique Home Directory (the folder where you will save your Final Cut Pro project, all
the files you use in your project, and anything you Export.) Propetly setting your System Settings ensures
that Final Cut Pro is saving Renders and Capture metadata to the same place. Best practice is to create a
separate folder for each Final Cut Pro project. This folder will then live within the “Final Cut Pro
Documents” folder that is automatically generated when you set your System Preferences when you start a
Final Cut Project. Get in the habit of saving everything to the Home Directory, and check your System
Settings everytime you open a project in Final Cut Pro. To set the System Settings, from the toolbar select
“Final Cut Pro” = “System Settings.” All you need to worry about is the far left tab called “Scratch
Disks.” You will need to set all four of the available options to the same folder. “Video Capture,” “Audio
Capture,” “Video Render,” and “Audio Render” all link from the first line. Then individually set your
“Waveform Cache,” “Thumbnail Cache,” and “Autosave Vault.” You can also choose to set or unset

Limit Capture Now at this point.
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Timeline: A window in Final Cut Pro that displays a chronological view of an open Sequence. Each
Sequence has its own tab in the Timeline. You can use the Timeline to edit and arrange a Sequence. The
order of the tracks in the Timeline determines the layering order when you combine multiple tracks of
video. Changes you make to a Sequence in the Timeline are seen when you play back that sequence in the
Canvas. If you modify clips in the Canvas, those changes can be seen in the Timeline. The Timeline is
divided in two. The top half displays Video files; the bottom half displays Audio files.

Title: Text that appears over the top of a video clip; create titles using the "Text" folder in the "Video
Generators" folder under the "Effects” tab in the Browser or in the Viewer in the lower right corner under

the “A” submenu: . Final Cut Pro does not handle text very well — and even though there are many
options for fonts, relatively few will actually look good on screen. See pages 16 — 18 for tips on optimizing
text.

Tool Palette: The tool palette is located to the left of the Timeline (when Final Cut Pro is arranged in
the Standard mode.) Here you will find several quick editing functions, among the most pertinent: the
“Selection tool,” “Razor tool,” and “Zoom tool.” Click on any of the icons once to use the tool. There are
also keyboard shortcuts that you can use. Please see pages 5 — 9 for more information about the Final Cut Pro
workspace and took.

User Preferences: You can set preferences to make your work flow more smoothly. For example, in
User Preferences you tell Final Cut Pro how many Undo actions to permit, what the timing for still
images should be, and what quality setting you wish to render. To find User Preferences, select “Final Cut
Pro” from the toolbar and then “User Preferences.”

Viewer: A window that displays a selected Clip. Make imaging and sound edits to Clips in the Viewer.
Make sure that you have selected the Clip you want to edit by checking the “Video” tab in the upper left
corner. The Viewer and the Canvas do not necessarily display the same footage. If you want to see the
changes you are making in the Viewer, set the Playhead in the Timeline to the same place as your selected

clip.
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Appendix A:
Final Cut Pro - Quick Training & Reference
for use with “Final Cut Pro Beginner & Intermediate Manual, Revision 003"

Please do not forget: You must set your System Settings every single time you open
your project in Final Cut Pro. Multiple students are using the same computer as you. If
you do not follow this guideline, you WILL lose work.

1.

2.

9.

Plug in your external harddrive with a firewire.
Put your tape in the mini-DV deck. Make sure the deck is on.

Open Final Cut Pro

If you see the image on page 4, this means that your deck is not on or it is not
connected with a firewire to the computer. Re-connect and press “Check Again.”
Now that Final Cut Pro is open, you need to set up a Home Directory on your
External Harddrive to save your project and all its related files. (See page 3)

Now that you have created a Home Directory, you need to set up Final Cut Pro to
link to it. Set up your System Settings. (See pages 4 & 5)

If you do not do this, you will get “Offline Clips” and your work may be lost! (See
page 32 for a definition of “Offline Clip” and what to do if it happens.)

Save your Final Cut Pro project to your Home Directory.

Familiarize yourself with the workspace. (See pages 6 — 9 for an explanation with
photos)

We will now put the video you taped with the camera on the computer.
This process is called “Capturing.” It occurs in “Real-time”...so if you have 1
hour of footage, it will take 1 hour to capture.
a) Open “Log and Capture” (See page 10).
If you get an error message, try “Refresh A/V devices.” If that does
not work, reset your “Audio/Video Settings.” (See page 10 for both)
b) A window (pictured on page 11) will appear. From here, you may
rewind, fast forward, stop, or play your tape.
c) Title your video in the Logging tab.
d) Press play in the “Log and Capture” window. Then select “Capture
Now.”
e) Once you are done capturing your footage, select “Escape.”
f) Close the “Log and Capture” window.

Your footage will now be located in the “Browser” window.

10. Bring your footage to the “Timeline.”
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

The top portion of the timeline is for Video files. The bottom if for Audio files.

Move your “Playhead” around in the timeline. You can see your footage in the
“Canvas.” If you double-click your footage, it also appears in the “Viewer.” When
vou move the Playhead, after selecting footage for the Viewer, the Canvas and the
Viewer will show different parts of your footage. The Canvas is a playback
monitor. Use the Viewer to add effects and transitions.

Zoom into your footage with either the zoom tool (See page 8) or the bar at the
bottom of the Timeline. (See page 7)

To play your footage, press either the Play button in the Canvas or press the space
bar.
It will begin from wherever your playhead is. It will only display in the Canvas.

Edit your footage in the timeline using the Selection tool and the Razor tool. (See
page 8 for tools; page 15 for Timeline editing)

Once you make a cut, delete excess. Your original video will remain intact. You
can always find it again in the Browser.

Most times, your audio and video will automatically be linked. In other words, if
you move the audio, the video moves with it. If you want to edit these separately,
try unlinking them. (See page 8)

You may also want to Lock tracks in order to edit Audio or Video separately. (See
page 16)

Now you have more than one “Clip.” You can drag them together for a quick and
easy edit. You can also add “Transitions.” (See pages 16 — 17 for Video, 22 — 24
for Audio)

If you want to add a still image, a song, or another file to your Final Cut Pro
project, you can “Import” them to the Browser. (See page 12 for Importing files to
your project, See pages 25 — 26 for iTunes instructions, if you want to add a
song.)

You must save these extra files to your Home Directory before importing them.
If you do not do this, you will get “Offline Clips” and your work may be lost! (See
page 32 for a definition of “Offline Clip” and what to do if it happens.)

For Voice Over, request an external microphone from John Kunhardt. Then
record yourself with your camera onto the mini-DV tape. Capture the footage
using “Log and Capture.”

Don'’t forget to name everything that you capture.

You can add “Titles” to your project. (See pages 17 — 18 for instructions and tips
on optimizing text)
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21. If you see a Red or a Green line on your Timeline, you need to “Render.” (See
pages 18 — 19).
You cannot playback footage with a Red line. You can playback footage with a
Green line, but it is not of optimum quality.

22. When you are done editing your video, you need to “Export.” (See pages 27 — 28
for instructions on how to export for Computer Playback.)
If you want to make a DVD, please see Marcus DeMaio or Sara Blaylock for
help.

23. Never forget to Save your project when you are done or while you are working.

24. Eject your external harddrive from the computer. Do not simply unplug! You may

corrupt / lose all your work.

For Final Cut Pro Assistance:

Sara Blaylock
sblaylock@ambherst.edu
Seely Mudd 110

(413) 542-5370

M-Th 9:30 - 6:00

F 8:00 - 4:30

Marcus DeMaio
mddemaio@ambherst.edu
Seely Mudd 114

(413) 542-2909

M-F  9:00 - 5:00

For Equipment:

John Kunhardt
jwkunhardt@ambherst.edu
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Appendix B:
Common Problems with Final Cut Pro
For all other problems, do not hesitate to contact Marcus DeMaio or Sara Blaylock.

1. Problems with Log and Capture

1. Firstof all: Log and Capture will NEVER function properly if you are using
the computer for ANYTHING else while it is running. Just use another
computer and wait.

2. You do not know how to open “Log and Capture.”
a. From the Menu Bar, go to “File” = “Log and Capture”

3. You do not know how to get rid of the “Log and Capture” window to return to
your editing.
a. Click the tiny circle in the upper left corner.

L Total Free Space 96.9 GB Total Free Time  (AV) 434.
@“m Click this to close this window

Preview Disabled

4. You do not know where your captured footage is.
a. Look in the Browser — the window in the upper left. All your imported
footage will be there. By default, Final Cut Pro calls it “Untitled1”.

5. You receive this message when you start “Log and Capture”:

] Unable to initialize video deck. You may still log offline
U clips or use Capture Now.

OK

Initializing Device Control...

a. Press OK.
i. Make sure that the mini-DV deck you are trying to use is
turned on.

ii. Make sure that the mini-DV deck is connected to the computer
via a firewire cable. It connects from the front of the mini-DV
deck to the back of the computer.
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iii. Now that you have the mini-DV deck connected properly, from
the menu bar, go to “View” = “Refresh A/V Devices.”
iv. Start “Log and Capture” again. It should be working.

6. You do not see play controls in the “Log and Capture” window, and it says

“ . . ”
o Communication.
000 Log and Capture
Total Free Time  (AV) 434.5 min Logging | Clip Settings | Capture Settings _

Total Free Space 97.0GB
([ ommos st (mniroms ) @ &
Reel: [001 )
N Nalme: ‘@ VM e
: /
sm::A :: 3 .
Shot/Take: ) o
T
Angle: @ v

Preview Disabled
Log Note: e

[ > Markers:

a. From the menu bar, go to “Final Cut Pro” = “Audio/Video Settings.”
b. Make sure that after “Device Control Presets” it says “Firewire NTSC”

Audio)Video Settings.

S\ S s | Cpar e | D Crel st | ANVDevss |

After setting this, from the Menu Bar, select “View” = “Refresh A/V
Settings.”

C.

7. “Log and Capture” is stalling.
a. While you are capturing, if your capture window stalls on one frame,

with this message “Locating timecode break (press ‘esc’ to stop)”,
AND you know that you have more video to import...
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Locating timecode break (press 'esc' 1o 5top)

Press escape on the keyboard.

Press play on the mini-DV deck and cue up the tape to the next portion
of your video tape that you would like to import.

Press “Now” on “Log and Capture.”

Notice that you will have several imported video clips in your Browser
window. By default, Final Cut Pro calls them “Untitled1, “Untitled2,”
etc. Just drag all these video clips into your Timeline individually to
edit.

2. You cannot hear your project

1. First, make sure that your computer is not on mute.
2. Then, make sure that the headphones are not plugged in.
3. If nothing has changed:

a.
b.
C.

From the menu bar, select “View.”
Scroll all the way down to “Audio Playback.”
If there is a checkmark next to “Audio Follows Video,” select this line
to uncheck it. The window will close.
| v Audio Follows Video

Go back to “View” = “Audio Playback”
Select “Default.” Note that “Audio Follows Video” Will now be grey.

v Default
Built-in Output

f. Now, go back to “View” = “Refresh A/V Devices.”
3. You have accidently closed a window and want to get it back
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1. From the menu bar, select “Window” = “Arrange” =2 “Standard”

Help
Send Behind ¥ . Sequence 1

f Arrange »

v Tool Palette

v Viewer ®1 Audio Mixing

v Canvas 82 Color Correction

v Tool Bench X5 Multiple Edits

v Timeline #3 Standard ~U

v Audio Meters X4 Two Up

v Browser #4 Save Window Layout...
Effects 85 Load Window Layout... QU
Favorites #®6

Export Queue

Timeline: Sequence 1 in Untitled Project 1
Browser

Canvas: Sequence 1 in Untitled Project 1
Viewer: Slug

Tool Bench

4. Your clips or media are offline and you cannot view them

An offline clip looks like this in the Browser:

buffalol.jpg
And like this in the Timeline:

Ol:OOIlO;

= bliffalol.jpg

And like this in the Canvas:

3 otooto17

Media Offline

buffalo1

1. First, make sure that your “System Settings” are set to your external
harddrive.
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|
1l
1l

3. Choose “Reconnect Media”

2. Now, Control-Click the offline clip in the Browser.

Offline...

Make
Duplicate as New Master Clip

Merge Clips.

Make Multiclip...
Make Multiclip Sequence...

Clip Settings...
kem Properties
Label

Rename

v

vvwv

4. In the window that appears, select “Search” and navigate to your external
harddrive. If you have not saved EVERYTHING to your harddrive every
single time you download or log and capture, you will not be able to

Reconnect your Media.
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